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1 Introduction

This document contains the most current information about the Collection 6.1 Moderate Resolution Imaging

Spectroradiometer (MODIS) Burned Area product suite. It is intended to provide the end user with practical

information regarding the use (and misuse) of the products, and to explain some of the more obscure and

potentially confusing aspects of the burned area products and MODIS products in general.

1.1 Summary of Collection 6.1 Algorithm and Product Changes

Initially driven by calibration issues that impacted the MODIS atmosphere products, a Collection 6.1 “mini-

reprocessing” was initiated in 2018 and later expanded to include the MODIS land products. For the land-

product suite the changes under Collection 6.1 are largely confined to the MODIS Level-1B calibrated

radiance products (e.g., MOD021KM) from which the various land products are derived.

The MODIS MCD64A1 burned area product is among those for which neither algorithm nor prod-

uct changes were made for Collection 6.1, and as such the Collection 6.1 MCD64A1 product is largely

unchanged from its Collection-6 predecessor (Figure 1). The small differences that occur across the two

collections are the result of the following changes:

1. The product is generated using the Collection 6.1 MODIS surface reflectance and active fire products

as inputs. The former in particular changed slightly as a result of 1) the changes made to the upstream

Collection-6.1 MODIS Level-1B calibrated radiance products, and 2) minor bug fixes made to the

surface reflectance production software.

2. For Collection 6, during some product months not all of the required MODIS active-fire input files

were properly staged within MODAPS for use as inputs to the MCD64A1 production software. For

Collection 6.1 this minor error was corrected, leading in some instances to a few extra days of active

fire observations at the beginning of the daily time series considered by the MCD64A1 mapping

algorithm.

3. The initially-delivered Collection 6 MCD64A1 production software contained a bug that caused

burned grid cells in columns 0 and/or 2399 (the left-most and right-most columns) of 26 specific

MODIS land tiles to be incorrectly relabeled as unburned. A bug fix was implemented in September

2018 but applied only to the forward processing stream. With Collection 6.1 this problem has been

resolved for the entire mission period.

The net result of the above changes is that the Collection 6 and Collection 6.1 MCD64A1 products are

sufficiently consistent to be intermixed for many purposes. This consistency can be seen in the right panel of

Figure 2, where we have selected the MCD64A1 product for August 2003 as a representative example. The

sole exception to the otherwise excellent agreement occurred for the November 2000 product, which proved

to be an isolated anomaly. We traced the atypical discrepancies observed for this month to the Collection 6.1

MODIS surface reflectance product, which is an input to the MCD64A1 mapping algorithm. It is not yet

clear why the Collection-6.1 surface reflectance product differed more significantly for just this particular

time period.

1.1.1 Reprocessing Schedule

The Collection-6 MCD64A1 product will remain in forward production through December 2021 while the

Collection-6.1 reprocessing of historical MODIS data is underway. After this date forward production of all

MODIS Land products (including MCD64A1) will continue via the Collection 6.1 reprocessing exclusively.
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Figure 1: Collection 6 (blue dashed lines) and Collection 6.1 (red solid lines) MCD64A1 monthly global

burned area time series for the first ∼8-years of the full MODIS data record. Collection 6.1 MCD64A1 data

for 2009 and beyond have not yet been produced at the time of this writing.
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Figure 2: Scatter plots of per-tile Collection-6.1 (C6.1) versus Collection-6 (C6) MCD64A1 total burned

area for November 2000 (left panel) and August 2003 (right panel). Each circle represents a tile (e.g.,

h08v05) on the MODIS sinusoidal grid during the specified calendar month. The gray and light blue lines

indicate the 1:1-reference and least-squares regression lines, respectively. The August 2003 example is

highly representative of the Collection-6.1 product in general. In contrast the November 2000 case is an

isolated anomaly for which the differences are much more pronounced.
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1.2 Terminology

1.2.1 Granules

A granule is an unprojected segment of the MODIS orbital swath containing about 5 minutes of data.

MODIS Level 0, Level 1, and Level 2 products are granule-based.

1.2.2 Tiles

MODIS Level 2G, Level 3, and Level 4 products are defined on a global 250-m, 500-m, or 1-km sinusoidal

grid (the particular spatial resolution is product-dependent). Because these grids are unmanageably large in

their entirety (43200 × 21600 pixels at 1 km, and 172800 × 86400 pixels at 250 m), they are divided into

fixed tiles approximately 10◦× 10◦ in size. Each tile is assigned a horizontal (H) and vertical (V) coordinate,

ranging from 0 to 35 and 0 to 17, respectively (Figure 3). The tile in the upper left (i.e. northernmost and

westernmost) corner is numbered (0,0).

Figure 3: MODIS tiling scheme.

Note that the Level 3 MODIS products generated on the MODIS sinusoidal grid are colloquially referred

to as having “1 km”, “500 m”, and “250 m” grid cells. The exact cell sizes are shown in Table 1.

Table 1: Sizes of grid cells in Level 3 tiled MODIS sinusoidal grid.

Colloquial Size Actual Size (m)

“1 km” 926.62543305

“500 m” 463.31271653

“250 m” 231.65635826
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1.2.3 Collections

Reprocessing of the entire MODIS data archive is periodically performed to incorporate better calibration,

algorithm refinements, and improved upstream data into all MODIS products. The updated MODIS data

archive resulting from each reprocessing is referred to as a collection. Later collections supersede all earlier

collections.

Neither the MCD45A1 nor MCD64A1 MODIS burned area product was produced in Collections 1

through 4. Both products were produced for the first time as part of Collection 5. For Collection 6 the

MCD45A1 burned area product was retired and replaced by MCD64A1.

1.2.4 Climate Modeling Grid (CMG)

MODIS Level 3 and Level 4 products can also be defined on a coarser-resolution climate modelling grid

(CMG). The objective is to provide the MODIS land products at consistent low resolution spatial and tem-

poral scales suitable for global modeling. In practice, there is a fair amount of variation in the spatial and

temporal gridding conventions used among the MODIS land CMG products.

2 MCD64A1 Algorithm Summary

The MCD64 burned-area mapping approach employs 500-m MODIS imagery coupled with 1-km MODIS

active fire observations. The hybrid algorithm applies dynamic thresholds to composite imagery generated

from a burn-sensitive vegetation index (VI) derived from MODIS short-wave infrared channels 5 and 7, and

a measure of temporal texture. The VI is defined as

VI =
ρ5 − ρ7
ρ5 + ρ7

,

where ρ5 and ρ7 are respectively the band 5 and band 7 atmospherically corrected surface reflectance.

Cumulative active fire maps are used to guide the selection of burned and unburned training samples and to

guide the specification of prior probabilities. The combined use of active-fire and reflectance data enables

the algorithm to adapt regionally over a wide range of pre- and post-burn conditions and across multiple

ecosystems. See Giglio et al. (2018) for a complete description of the algorithm.

The mapping algorithm ultimately identifies the date of burn, to the nearest day, for 500-m grid cells

within the individual MODIS tile being processed. The date is encoded in a single data layer of the output

product as the ordinal day of the calendar year on which the grid cell burned (range 1-366), with a value

of 0 for unburned land grid cells and additional special values reserved for missing-data and water grid

cells. The output product contains additional data layers for diagnostic purposes and to facilitate uncertainty

propagation into downstream products derived from the burned area maps, such as emissions estimates.

3 MCD64 Product Suite

Three different versions of the MODIS burned area product are available:

• The official MCD64A1 product in HDF-EOS format, which is available as part of the MODIS suite

of global land products.

• The re-projected monthly GeoTIFF version available from the University of Maryland.

• The re-projected monthly Shapefile version available from the University of Maryland.
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3.1 Level 3 Monthly Tiled Product: MCD64A1

The MCD64A1 Burned Area Product is a monthly, Level-3 gridded 500-m product containing per-pixel

burning and quality information, and tile-level metadata.

3.1.1 Naming Convention

The file naming convention, which has been adopted by all standard MODIS products, is as follows:

MCD64A1.AYYYYDDD.hHHvVV.061.PPPPPPPPPPPPP.hdf

where

YYYY = year mapped

DDD = start day-of-year (Julian day) of calendar month in which burns have been mapped (Table 2)

HH = horizontal tile coordinate on MODIS sinusoidal grid

VV = vertical tile coordinate on MODIS sinusoidal grid

061 = collection identifier

PPPPPPPPPPPPP = production date1

Example: The product file MCD64A1.A2006244.h31v10.061.2021106034604.hdf contains the

September 2006 burned area map for MODIS tile h31v10, located in northern Australia.

Table 2: Day-of-year (DOY) of the first day of each calendar month. The DDD field (see above) in the file

names of the MCD64 products will always have one of the 22 unique values shown here.

Non-Leap Year Leap Year

Month Start DOY Start DOY

January 1 1

February 32 32

March 60 61

April 91 92

May 121 122

June 152 153

July 182 183

August 213 214

September 244 245

October 274 275

November 305 306

December 335 336

1This naming convention ensures that files always have a unique name: if a tile is reprocessed the last number, indicating the

day and time in which the file was processed, will be different, thus avoiding any confusion with obsolete data.
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3.1.2 Data Layers

The product contains five data layers (Burn Date, Burn Date Uncertainty, QA, First Day, and Last Day),

each stored as a separate HDF4 Scientific Data Set (SDS).

Burn Date: Ordinal day of burn (1-366) for each 500-m grid cell, with 0 = unburned land, -1 = unmapped

due to insufficient data, and -2 = water.

Burn Date Uncertainty: Estimated uncertainty in date of burn, in days. Unburned and unmapped grid

cells will always have a value of 0 in this layer.

QA: 8-bit quality assurance bit field.

bit 0: 0 = water grid cell, 1 = land grid cell.

bit 1: Valid data flag (0 = false, 1 = true). A value of 1 indicates that there was sufficient valid data

in the reflectance time series for the grid cell to be processed. (NB. Water grid cells will always

have this bit clear.)

bit 2: Shortened mapping period (0 = false, 1 = true). This flag indicates that the period of reliable

mapping does not encompass the full one-month product period, i.e., burns could not be reliably

mapped over the full calendar month.

bit 3: Grid cell was relabeled during the contextual relabeling phase of the algorithm (0 = false, 1 =

true).

bit 4: Spare bit set to 0.

bits 5–7: Special condition code reserved for unburned grid cells. This code provides an explanation

for any grid cells that were summarily classified as unburned by the detection algorithm due to

special circumstances.

0: None or not applicable (i.e., burned, unmapped, or water grid cell).

1: Valid observations spaced too sparsely in time.

2: Too few training observations or insufficient spectral separability between burned and un-

burned classes.

3: Apparent burn date at limits of time series.

4: Apparent water contamination.

5: Persistent hot spot.

6: Reserved for future use.

7: Reserved for future use.

First Day and Last Day: The First Day and Last Day SDSs indicate the first and last days, respectively,

on which changes could be reliably detected within the time series, on a per-grid-cell basis. Note

that during periods of persistent cloud cover or frequent data loss, these dates will often lie within the

calendar month that was mapped, indicating that reliable mapping could not be achieved over the full

month.
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3.1.3 Metadata

As with standard MODIS products, the MCD64A1 product contains global metadata stored in the ECS

CoreMetadata.0 and ArchiveMetadata.0 global attributes. For convenience, a subset of these metadata as

well as additional metadata are stored as standard HDF global attributes (Table 3).

Table 3: MCD64A1 metadata stored as standard global HDF attributes.

Attribute Name Description

BurnedCells Number of burned 500-m land grid cells during product month.

MissingCells Number of 500-m land grid cells during product month having too

few valid observations for algorithm to function.

LandCells Number of 500-m land grid cells in tile.

ValidLandCells Number of 500-m land grid cells for which mapping could be per-

formed.

ProductStartDay Julian start day of product calendar month (range 1 – 336).

ProductEndDay Julian end day of product calendar month (range 31 – 366).

year Product year.

tile Six-character tile descriptor, e.g., “h20v11”.
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3.1.4 Example Code

Example 1: IDL code to read a global attribute and two SDSs in the MCD64A1 product.

mcd64a1_file = ’MCD64A1.A2006213.h20v11.061.2021105210759.hdf’

sd_id = HDF_SD_START(mcd64a1_file, /READ)

; read "BurnedCells" attribute

attr_index = HDF_SD_ATTRFIND(sd_id, ’BurnedCells’)

HDF_SD_ATTRINFO, sd_id, attr_index, DATA=burned_cells

; convert 1-element vector to scalar

burned_cells = burned_cells[0]

index = HDF_SD_NAMETOINDEX(sd_id, ’Burn Date’)

sds_id = HDF_SD_SELECT(sd_id, index)

HDF_SD_GETDATA, sds_id, burn_date

HDF_SD_ENDACCESS, sds_id

index = HDF_SD_NAMETOINDEX(sd_id, ’QA’)

sds_id = HDF_SD_SELECT(sd_id, index)

HDF_SD_GETDATA, sds_id, QA

HDF_SD_ENDACCESS, sds_id

HDF_SD_END, sd_id

help, burned_cells, burn_date, QA

The code produces the following output:

BURNED_CELLS LONG = 91474

BURN_DATE INT = Array[2400, 2400]

QA BYTE = Array[2400, 2400]

12



Example 2: Python code to read the ”Burn Date“ and “QA” SDSs in the MCD64A1 product.

import gdal

import numpy as np

in_file = "MCD64A1.A2006244.h31v10.061.2021106034604.hdf"

hdf_handle = gdal.Open(in_file)

# Print a list of all of the datasets within the hdf file

sds_list = hdf_handle.GetSubDatasets()

for sds in sds_list:

print(sds)

# Open a subdataset "N" as an array with sds_list[N][0], values of N are:

# 0 = ’Burn Date’, 1 = ’Burn Date Uncertainty’, 2 = ’QA’,

# 3 = ’First Day’, 4 = ’Last Day’

burndate_handle = gdal.Open(sds_list[0][0])

burndate_data = burndate_handle.ReadAsArray()

qa_handle = gdal.Open(sds_list[2][0])

qa_data = qa_handle.ReadAsArray()

# Array can be handled with Numpy now

print(np.shape(burndate_data))

print(qa_data.dtype)

# Clean up when done

del qa_data, qa_handle, burndate_data, burndate_handle

13



Example 3: MATLAB code to read the MCD64A1 “Burn Date” SDS using the MATLAB routine hdfread.

This is probably the easiest way to read individual HDF SDSs in MATLAB.

mcd64a1_file = ’MCD64A1.A2006213.h20v11.061.2021105210759.hdf’

% read burn date layer in one shot

burn_date = hdfread(mcd64a1_file, ’Burn Date’);

% display burn date (transposed so that North appears on top)

imagesc(burn_date.’);

Example 4: Longer version of MATLAB code to read the MCD64A1 “Burn Date” layer. This is probably

the better approach to use if multiple SDSs or multiple spatial subsets of an SDS will be read since the HDF

file will be opened and closed only once. (The shorter approach using hdfread requires that the file be

opened and closed for each read.)

mcd64a1_file = ’MCD64A1.A2006244.h31v10.061.2021106034604.hdf’

sd_id = hdfsd(’start’, mcd64a1_file, ’DFACC_RDONLY’);

sds_index = hdfsd(’nametoindex’, sd_id, ’Burn Date’);

sds_id = hdfsd(’select’, sd_id, sds_index);

% prepare to read entire SDS (always 2400 x 2400 pixels in size)

start = [0,0];

edges = [2400,2400];

[burn_date, status] = hdfsd(’readdata’, sds_id, start, [], edges);

status = hdfsd(’endaccess’, sds_id);

status = hdfsd(’end’, sd_id);

% display burn date (transposed so that North appears on top)

imagesc(burn_date.’);
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Example 5: C code for reading MCD64A1 burn date layer using HDF library functions.

#include <stdio.h>

#include <stdlib.h>

#include "mfhdf.h"

#define ROWS 2400

#define COLS 2400

main(int argc, char **argv)

{

int32 sd_id, sds_index, sds_id;

int32 rank, data_type, nattr, dim_sizes[MAX_VAR_DIMS];

int32 start[2], int32 edges[2];

char *infile;

int i, j;

long nburn;

uint16 burn_date[ROWS][COLS];

infile = "MCD64A1.A2006244.h31v10.061.2021106034604.hdf";

if ((sd_id = SDstart(infile, DFACC_READ)) == FAIL) exit(1);

start[0] = start[1] = 0;

edges[0] = ROWS;

edges[1] = COLS;

if ((sds_index = SDnametoindex(sd_id, "Burn Date")) == FAIL) exit(2);

if ((sds_id = SDselect(sd_id, sds_index)) == FAIL) exit(3);

if (SDgetinfo(sds_id, (char *) NULL, &rank, dim_sizes, &data_type,

&nattr) == FAIL) exit(4);

/* check rank and data type */

if (rank != 2) exit(5);

if (data_type != DFNT_UINT16) exit(6);

if (SDreaddata(sds_id, start, NULL, edges,

(void *) burn_date) == FAIL) exit(7);

if (SDendaccess(sds_id) == FAIL) exit(8);

if (SDend(sd_id) == FAIL) exit(9);

/* simple example: count burned grid cells */

nburn = 0L;

for (i = 0; i < ROWS; i++) {

for (j = 0; j < COLS; j++)

if (burn_date[i][j] > 0) nburn++;

}

printf("%d burned grid cells.\n", nburn);

exit(0);

}
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3.2 GeoTIFF subset for GIS visualization and analysis: MCD64monthly

A user-friendly GeoTIFF version of the MCD64 product is derived from the standard MCD64A1 HDF

version by University of Maryland. The GeoTIFF files are reprojected in Plate-Carrée projection and cover a

set of sub-continental windows (Figure 4). A table containing the regions covered and bounding coordinates

of the 24 windows is available in Appendix A.
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Figure 4: Coverage of the GeoTIFF subsets. A table of bounding coordinates is available in Appendix A.

3.2.1 Naming Convention

The GeoTIFF files follow a naming convention similar to the official MCD64A1 product. However, as the

GeoTIFF files are obtained by mosaicing, resampling, and reprojecting several tiles of the original product,

the processing time is not available. Example product file names are:

MCD64monthly.A2000306.Win01.006.burndate.tif

MCD64monthly.A2000306.Win01.006.ba_qa.tif

where

MCD64monthly = monthly GeoTIFF version of MCD64A1

A2000306 = year and Julian date of the starting day of the month covered by the product: 306 is the Julian

date of Nov 1, hence 2000306 means that the product covers November 2000.

Win01 = spatial extent: the file covers window 1 (Alaska)

006 = version identifier (Collection 6)

burndate/ba qa = file content: unlike HDF, GeoTIFF files contain a single layer. Currently, two layers

of the original product are available as GeoTIFF files: “Burn Date” and “QA”.
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3.2.2 Example Code

Example 6: IDL code to read the GeoTIFF MCD64monthly “Burn Date” product. Although not shown

in this example, the IDL QUERY TIFF function can be used to determine information about the GeoTIFF

image without having to read it into memory.

infile = ’MCD64monthly.A2016183.Win13.006.burndate.tif’

; read entire image

burn_date = read_tiff(infile, GEOTIFF=geo)

; now read just a spatial subset

burn_date_subset = read_tiff(infile, SUB_RECT = [1000, 1000, 400, 400])

help, burn_date

help, burn_date_subset

help, geo, /STRUCT

The code produces the following output:

BURN_DATE INT = Array[7055, 4552]

BURN_DATE_SUBSET

INT = Array[400, 400]

** Structure <18147a8>, 10 tags, length=120, data length=114, refs=1:

MODELPIXELSCALETAG

DOUBLE Array[3]

MODELTIEPOINTTAG

DOUBLE Array[6, 1]

GTMODELTYPEGEOKEY

INT 2

GTRASTERTYPEGEOKEY

INT 2

GTCITATIONGEOKEY

STRING ’Geographic (Longitude, Latitude) Unspe’...

GEOGRAPHICTYPEGEOKEY

INT 32767

GEOGGEODETICDATUMGEOKEY

INT 32767

GEOGANGULARUNITSGEOKEY

INT 9102

GEOGSEMIMAJORAXISGEOKEY

DOUBLE 0.0000000

GEOGSEMIMINORAXISGEOKEY

DOUBLE 0.0000000
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3.3 Shapefile subset for GIS visualization and analysis: MCD64monthly

Shapefiles of the MCD64A1 Burn Date layer are derived from the monthly GeoTIFF files by the University

of Maryland. The shapefiles are available with the same projection (Plate-Carrée) and geographic extent

used for the GeoTIFF sub-continental windows (Figure 4).

3.3.1 Naming Convention

The shapefile naming convention is identical to the GeoTIFF naming convention. Each shapefile consists of

multiple files which must remain in the same subdirectory. For convenience, shapefiles are distributed as a

zipped tar archive file (“.tar.gz”) containing the four shapefile elements. MCD64monthly shapefile archives

are named as follows:

MCD64monthly.A2000306.Win01.006.burndate.shapefiles.tar.gz

which in turn contains the following files:

MCD64monthly.A2000306.Win01.006.burndate.shp

MCD64monthly.A2000306.Win01.006.burndate.shx

MCD64monthly.A2000306.Win01.006.burndate.prj

MCD64monthly.A2000306.Win01.006.burndate.dbf

where

MCD64monthly = monthly shapefile version of MCD64A1

A2000306 = year and Julian date of the starting day of the calendar month covered by the product (here

November 2000).

Win01 = spatial extent: the file covers window 1 (Alaska)

006 = version identifier (Collection 6)

burndate = file content.
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3.4 MCD64CMQ Climate Modeling Grid Burned Area Product

The CMG burned area product is a gridded summary intended for use in regional and global modeling.

3.4.1 Naming Convention

The MCD64CMQ monthly product files follow the standard MODIS product naming convention. Examples:

MCD64CMQ.A2003213.006.2017283041945.hdf August 2003 product file

MCD64CMQ.A2003214.006.2017283041945.hdf August 2004 product file

3.4.2 Global Grid

Each data layer has 720 rows and 1440 columns comprising a global 0.25◦ grid. The center of the upper left

grid cell is located at longitude 179.875◦W, 89.875◦N. One data layer has an additional dimension (i.e., it is

three dimensional) as described below.

3.4.3 Data Layers

Each product file nominally contains four data layers (BurnedArea, QA, UnmappedFraction, and Land-

CoverDist), each stored as a separate HDF4 Scientific Data Set (SDS). Note that the LandCoverDist SDS

will be absent from the most recent MCD64CMQ product files due to the ∼1-year forward production lag

in the MCD12Q1 annual land cover product used to populate this layer. Such incomplete MCD64CMQ

product files have a global string attribute named LandCoverNote and will be reprocessed when the relevant

annual MCD12Q1 product becomes available.

BurnedArea: Monthly area burned. The scaled values stored in this SDS must be multiplied by a factor of

0.01 to obtain burned area in hectares.

QA: 8-bit quality assurance bit field. 0 = water, 1 = unprocessed land, 2 = processed land.

UnmappedFraction: Combined spatial and temporal fraction of the unmapped land area within each grid

cell [percent]. Specifically, this quantity is the average number of days that could be mapped during

the one-month product period over all 500-m land grid cells falling within each 0.25◦ bin, divided

by the number of days in the product calendar month. The resulting proportion is expressed as a

percentage.

Note that the unmapped fraction does not merely tally those 500-m grid cells in the MCD64A1 product

classified as unmapped (such grid cells have a value of -1 in the MCD64A1 Burn Date SDS), for which

the number of days mapped is zero. Rather, the quantity represents an average over all 500-m land

grid cells, whether they are entirely unmapped, partially mapped due to a shortened mapping period

(bit 2 set in the MCD64A1 QA SDS), or fully mapped during the product period.

Unprocessed land grid cells (see QA layer above) will have an unmapped fraction of 100%.

LandCoverDist: A breakdown (to the nearest percent) of the area burned in each grid cell by the 16 dif-

ferent UMD land cover classes available in the Collection 6 MCD12Q1 land cover product. These

classes, which have been slightly modified for Collection 6, are shown below. The number in each

row is the index into the specific plane of the three-dimensional LandCoverDist array that contains

the percentage of the area burned for the corresponding land cover type.
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0 water 8 woody savannas

1 evergreen needleleaf forests 9 savannas

2 evergreen broadleaf forests 10 grasslands

3 deciduous needleleaf forests 11 permanent wetlands

4 deciduous broadleaf forests 12 croplands

5 mixed forests 13 urban and built-up

6 closed shrublands 15 barren

7 open shrublands 16 unclassified

Note: The Collection 6 MCD12Q1 UMD land cover layer suffers from a bug that often assigns 500-m

grid cells an invalid class value of 14 (the IGBP “cropland/natural vegetation mosaics” class).2 This

incorrect class propogates into the MCD64CMQ product, and we therefore strongly advise users to ig-

nore the LandCoverDist layer until the problem is corrected. In the interim all new C6 MCD64CMG

product files are being being generated without the LandCoverDist layer. We will regenerate the

MCD64CMQ product using the corrected Collection 6.1 MCD12Q1 product when it becomes avail-

able in 2021.

3.4.4 Metadata

File-level metadata are stored as global attributes in the HDF product files (Table 4).

Table 4: MCD64CMQ metadata stored as standard global HDF attributes.

Attribute Name Description

ShortName Short name of product (“MCD64CMQ”).

Instrument Instrument name (“MODIS”).

BinSize Global grid bin size in degrees (0.25).

StartDate Start date of monthly product to nearest second.

EndDate End date of monthly product to nearest second.

NumInputBA Number of MCD64A1 input files (nominally 268).

InputPointerBA Comma-separated list of MCD64A1 input file names.

NumInputLC Number of MCD12Q1 input files.

InputPointerLC Comma-separated list of MCD12Q1 input file names.

LandCoverNote String attribute present only in product files lacking the LandCoverDist SDS. Ex-

ample value: “2018 MCD12Q1 product not available at time of processing”.

2See https://landweb.modaps.eosdis.nasa.gov/cgi-bin/QS/new/pages.cgi?name=known_issues,

case number PM MCD12 19074.
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3.4.5 Example Code

Example 7: IDL code to read the MCD64CMQ BurnedArea SDS.

pro cmg_demo

COMPILE_OPT STRICTARR, STRICTARRSUBS

mcd64cmq_file = ’MCD64CMQ.A2018001.006.2018149165520.hdf’

sd_id = HDF_SD_START(mcd64cmq_file, /READ)

index = HDF_SD_NAMETOINDEX(sd_id, ’BurnedArea’)

sds_id = HDF_SD_SELECT(sd_id, index)

; read SDS scale factor attribute

attr_index = HDF_SD_ATTRFIND(sds_id, ’scale_factor’)

HDF_SD_ATTRINFO, sds_id, attr_index, DATA=scale_factor

; IDL returns scalar numeric attributes as a 1-element vector

; next line will convert it to a scalar

scale_factor = scale_factor[0]

; read SDS units attribute

attr_index = HDF_SD_ATTRFIND(sds_id, ’units’)

HDF_SD_ATTRINFO, sds_id, attr_index, DATA=units

; read scaled data

HDF_SD_GETDATA, sds_id, ScaledAburn

HDF_SD_ENDACCESS, sds_id

HDF_SD_END, sd_id

help, ScaledAburn, scale_factor, units

Aburn = scale_factor * temporary(ScaledAburn)

help, Aburn

; calculate total area burned worldwide

Atotal = total(Aburn, /DOUBLE) ; ha

print, Atotal/1.0e6, FORMAT=’("Total burned area is",F6.2," Mha")

end

The code produces the following output:

SCALEDABURN LONG = Array[1440, 720]

SCALE_FACTOR FLOAT = 0.0100000

UNITS STRING = ’hectares’

ABURN FLOAT = Array[1440, 720]

Total burned area is 26.91 Mha
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Example 8: IDL code to generate vectors containing the the latitude and longitude at the center of each

0.25◦ grid cell.

pro cmg_nav

COMPILE_OPT STRICTARR, STRICTARRSUBS

XGRID = 1440

YGRID = 720

bin_size = 0.25 ; degrees

lat = (90.0 - bin_size/2) - bin_size * indgen(YGRID) ; degrees

lon = (-180.0 + bin_size/2) + bin_size * indgen(XGRID) ; degrees

; print center latitude and longitude of first 24 rows/columns of grid

help, lat

print, lat[0:23], FORMAT=’(8F9.3)’

help, lon

print, lon[0:23], FORMAT=’(8F9.3)’

end

The code produces the following output:

LAT FLOAT = Array[720]

89.875 89.625 89.375 89.125 88.875 88.625 88.375 88.125

87.875 87.625 87.375 87.125 86.875 86.625 86.375 86.125

85.875 85.625 85.375 85.125 84.875 84.625 84.375 84.125

LON FLOAT = Array[1440]

-179.875 -179.625 -179.375 -179.125 -178.875 -178.625 -178.375 -178.125

-177.875 -177.625 -177.375 -177.125 -176.875 -176.625 -176.375 -176.125

-175.875 -175.625 -175.375 -175.125 -174.875 -174.625 -174.375 -174.125

22



4 Obtaining the MODIS Burned Area Products

All MODIS products are available free of charge. The MODIS Burned Area Product is available for order-

ing from the Land Processes Distributed Active Archive Center (LP-DAAC).3 Additionally, a secure FTP

(SFTP) server is maintained by the University of Maryland, primarily to assist science users who need to

regularly download large volumes of data.

4.1 Downloading the products from the fuoco SFTP server

The MODIS burned area product is available for download in either HDF, GeoTIFF, or Shapefile format

from the University of Maryland fuoco SFTP (formerly FTP) server. Connect using the following infor-

mation:

Server: fuoco.geog.umd.edu

Login name: fire

Password: burnt

Note: As a consequence of our mandatory transition from FTP to SFTP4, most users will not be able to

download product files using their regular web browser without first installing a third-party browser exten-

sion.

For downloading product files you can use the command-line sftp and lftp clients, or freely available

GUI file transfer software such as FileZilla (https://filezilla-project.org) and Cyberduck

(https://cyberduck.io/). SFTP-capable commercial software is also available and includes the ex-

amples listed below.

For Windows:

• SmartFTP (https://www.smartftp.com/)

• WinSCP (https://winscp.net)

For MacOS:

• ForkLift (https://binarynights.com/)

• Commander One (https://mac.eltima.com/file-manager.html)

• Transmit (https://panic.com/transmit/)

• Viper FTP (https://viperftp.com/)

• Flow (http://fivedetails.com/)

3https://lpdaac.usgs.gov/
4In our case the change in protocol was not driven by a need for encryption – here such a requirement would be pointless given

that 1) the data are intended to be freely available and 2) we openly share the password – but instead to avoid various port-level

server vulnerabilities associated with FTP.
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Once connected, enter the data subdirectory to access the following abridged directory tree:

.

|-- GFED

|-- MODIS

| |-- C6

| | |-- docs

| | |-- MCD14ML

| | |-- MCD64A1

| | | |-- HDF

| | | | ‘-- h00v08, h00v09, ..., h35v10

| | | |-- SHP

| | | | ‘-- Win01, Win02, ..., Win24

| | | | ‘-- 2000, 2001, 2002, ...

| | | ‘-- TIFF

| | | ‘-- Win01, Win02, ..., Win24

| | | ‘-- 2000, 2001, 2002, ...

| | |-- MCD64CMQ

| | ‘-- Mx14CMQ

| ‘-- C61

|-- VIIRS

‘-- VIRS

Note: The C61 subdirectory is currently empty but will be populated with reprocessed Collection 6.1 prod-

ucts later this year.

4.1.1 HDF Files

As can be seen from the directory tree, the file system on this server is structured to organize the HDF

MCD64A1 product hierarchically by tile. Specifically, all MCD64A1 HDF product files for a given tile are

located in the directory MODIS/C6/MCD64A1/HDF/hHHvVV, where HH is the horizontal tile coordinate

and VV is the vertical tile coordinate. For example, the Collection 6 MCD64A1 HDF files for MODIS tile

h08v05 will be found in the directory MODIS/C6/MCD64A1/HDF/h08v05.

4.1.2 GeoTIFF files and Shapefiles

The layout of GeoTIFF files and Shapefiles on the server is structured to organize the data hierarchically by

window, and then by year. All the data for the same window from the same year is located (for GeoTIFF

files and shapefiles, respectively) in a the directories MODIS/C6/MCD64A1/TIF/WinXX/YYYY/ and

MODIS/C6/MCD64A1/SHP/WinXX/YYYY/, where XX is the number of the window (Figure 4) and

YYYY is the year. For example, the directory MODIS/C6/MCD64A1/Win01/2001 contains all of the

GeoTIFF files for the year 2001 for window 01 (Alaska).
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4.1.3 Example sftp command line session

Here we use wildcards with the SFTP get command to download the January 2013 MCD64A1 HDF prod-

uct for the entire globe (i.e., all 268 MODIS land tiles for which the product is produced).

$ sftp fire@fuoco.geog.umd.edu

Password:

Connected to fuoco.geog.umd.edu.

sftp> cd data

sftp> ls

GFED MODIS VIIRS VIRS

sftp> cd MODIS/C6/MCD64A1/HDF

sftp> progress

Progress meter disabled

sftp> get h??v??/MCD64A1.A2013001*
Fetching /data/MODIS/C6/MCD64A1/HDF/h00v08/MCD64A1.A2013001.h00v08.006.2017...

to MCD64A1.A2013001.h00v08.006.2017013041920.hdf

Fetching /data/MODIS/C6/MCD64A1/HDF/h00v09/MCD64A1.A2013001.h00v09.006.2017...

to MCD64A1.A2013001.h00v09.006.2017013052550.hdf

Fetching /data/MODIS/C6/MCD64A1/HDF/h00v10/MCD64A1.A2013001.h00v10.006.2017...

to MCD64A1.A2013001.h00v10.006.2017013041341.hdf

.

.

.

Fetching /data/MODIS/C6/MCD64A1/HDF/h35v08/MCD64A1.A2013001.h35v08.006.2017...

to MCD64A1.A2013001.h35v08.006.2017013053444.hdf

Fetching /data/MODIS/C6/MCD64A1/HDF/h35v09/MCD64A1.A2013001.h35v09.006.2017...

to MCD64A1.A2013001.h35v09.006.2017013053444.hdf

Fetching /data/MODIS/C6/MCD64A1/HDF/h35v10/MCD64A1.A2013001.h35v10.006.2017...

to MCD64A1.A2013001.h35v10.006.2017013042434.hdf

sftp> bye
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5 Working with the product in ENVI 4.8

5.1 MCD64A1 (HDF)

HDF MODIS products are only partially supported in ENVI. To open them, select File → Open External

Files → Generic Formats → HDF. Opened as a generic HDF file, all geographic information is lost. To

restore this information the projection parameters must be entered manually.

5.2 MCD64monthly (GeoTIFF)

The GeoTIFF files are fully compatible with ENVI. To open them, simply go through the File → Open

Image File menu.

5.3 MCD64monthly (Shapefile)

Shapefiles are not directly supported in ENVI, rather they are converted to the ENVI Vector File (“.evf”)

format during ingest. To load a shapefile, select Vector → Open Vector File and choose the Shapefile

wildcard filter setting (“*.shp”). When prompted to set “Import Vector Files Parameters”, set the desired

layer name and output file location and select “OK”. Do not adjust the projection information; the default

values correspond to the Plate-Carrée projection used by the GeoTIFF files. Use the “Available Vectors List”

(Vector → Available Vectors List) to overlay the vectors on an existing display, or display them in a new

window.

6 Working with the product in ArcGIS

Handling HDF-EOS files is not straightforward in ArcGIS. We recommend that users of the standard HDF-

EOS product perform any scientific analysis in other software packages (e.g., ENVI) and then export their

output to ArcGIS in a different format such as GeoTIFF.

6.1 MCD64monthly (GeoTIFF)

The MCD64 GeoTIFF files can be directly loaded into ArcGIS through Add Layer. In order to display the

burned areas only, under Layer Properties → Unique Values → Symbology set the color to “No Color” for

the following Values:

• 0 - unburned

• -1 - missing data

• -2 - water

ArcGIS will display the burned area in Julian days of the given month in either individual colors or in

the same color depending on your settings. An example is shown in Figure 5.
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Figure 5: Display of GeoTIFF from August 2010, Window 20. Each burn day of the month is shown in a

different color.

6.1.1 Area of Interest (AoI)

In order to reduce the file size of the regional GeoTIFF and focus on a specific region, an “area of interest

(AoI)” spatial subset can be extracted.

1. Display desired AoI

2. Right mouse click data layer

3. Data → Export Data

The “Export Raster Data” window will open (Figure 6). Check both data frames options to Current and

choose TIFF in the Format field.

6.2 MCD64monthly (Shapefile)

The Shapefiles can directly be loaded into ArcGIS via Add Layer. To change the appearance of the file, select

Layer Properties → Symbology → Graduated Colors. Optionally, to remove the outlines of the data, right

click a symbol in the Graduated Colors panel and select “Properties For All Symbols”, then set “Outline

Color” to “No Color”. An example is shown in shown in Figure 7.
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Figure 6: ArcGIS export raster window.

Figure 7: Left: True-color (R, G, B) Landsat 7 scene acquired 20 October 2002 at path 98, row 71. Right:

MCD64monthly October Shapefile superimposed over the burned area. Older burned areas are shown in

blue tones, newer burns are shown in red tones.
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7 Validation of the MODIS Burned Area Product

The Collection 6 product has been validated at Stage 3 by comparison with Landsat 8 Operational Land

Imager (OLI) image pairs acquired 16 days apart that were visually interpreted. These independent refer-

ence data were selected using a stratified random sampling approach that allows for probability sampling of

Landsat data in both time and in space. A total of 558 Landsat 8 OLI image pairs (1116 images), acquired

between 1 March 2014 and 19 March 2015, were selected. Globally, the MCD64A1 product had an esti-

mated 40.2% commission error and 72.6% omission error; the prevalence of omission errors is reflected by a

negative estimated bias of the mapped global area burned relative to the Landsat independent reference data

(-54.1%). Globally, the standard errors of the accuracy metrics were less than 6%. The product accuracy

was also characterized at coarser scale using metrics derived from the regression between the proportion of

coarse resolution grid cells detected as burned by MCD64A1 and the proportion mapped in the Landsat 8

interpreted maps. The errors of omission and commission observed at 30-m resolution compensate to a

considerable extent at coarser resolution, as indicated by the coefficient of determination (r2 > 0.70), slope

(> 0.79) and intercept (-0.0030) of the regression between the MCD64A1 product and the Landsat indepen-

dent reference data in 3-km, 4-km, 5-km, and 6-km coarse resolution cells. The analysis of the deviations

between the proportion of area burned mapped by the MCD64A1 product and by the independent reference

data, performed using 3-km × 3-km and 6-km × 6-km coarse resolution cells, indicates that the large neg-

ative bias in global area burned is primarily due to the systematic underestimation of smaller burned areas

in the MCD64A1 product. Full details of the product validation may be found in Bochetti et al. (2016) and

Boschetti et al. (2019).

8 Known Problems

8.1 Cropland Burning

Burned areas in cropland should generally be treated as low confidence due to the inherent difficulty in

mapping agricultural burning reliably. See Hall et al. (2016) for more information about the complications

unique to cropland-fire mapping.

8.2 Pre-November 2000 Mission Period

Although the Terra MODIS first began acquiring data in February 2000, crosstalk and calibration remained

problematic until early November 2000. For this reason we do not distribute the MODIS burned area product

for the mission period preceding November 2000.

8.3 June 2001 Terra MODIS Outage

The June 2001 monthly product is heavily degraded due to extended Terra MODIS outages.
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8.3.1 August 2020 Aqua Outage

A failure of the Aqua formatter-multiplexer unit (FMU) on 16 August 2020 led to the loss of regular science

data telemetry for a period of about two weeks. During this time the MODIS instrument remained otherwise

functional, and an effort was made to generate the standard Aqua science products from Direct Broadcast

Aqua MODIS data collected by Direct Readout ground stations around the world. A representative example

of the limited Direct Broadcast coverage obtained during the outage is shown in in Figure 8.

While essentially all Aqua science data over Africa, eastern Asia, Indonesia, and Oceana were lost

during the two-week outage period, we do not expect the loss to significantly degrade the MCD64A1 burned

area product in these regions since the Terra MODIS continued to function normally.

Figure 8: Representative Direct Broadcast coverage available during the 16 August – 2 September 2020

Aqua FMU outage period, using the MODIS active fire (not burned area) product as an example. Fire pixels

are shown in red, clear land pixels are shown in green, cloud pixels are shown in light blue, and areas lacking

data are shown in white. Browse image courtesy of the LDOPE.

9 Frequently Asked Questions

Is there an existing tool I can use to remap the tiled MODIS products into a different projec-

tion?

The now-defunct MODIS Reprojection Tool (MRT) and follow-on HDF-EOS to GeoTIFF Conversion Tool

(HEG) can remap the tiled MODIS products into many different projections; see Section 11.
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How do I calculate the latitude and longitude of a grid cell in the Level 3 products?

You can use the online MODLAND Tile Calculator5, or perform the calculation as described in Appendix B.

How do I calculate the tile and grid cell coordinates of a specific geographic location (latitude

and longitude)?

You can use the online MODLAND Tile Calculator, or perform the calculation as described in Appendix B.
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11 Relevant Web and FTP Sites

• MODIS Fire and Thermal Anomalies: General information about the MODIS Fire (Thermal Anoma-

lies) and Burned Area products.

https://modis-fire.umd.edu/

• MODIS Land: Information about the MODIS Land products.

https://modis-land.gsfc.nasa.gov/index.html

• MODIS Land Product Quality Assessment: Product quality-assessment (QA) related information,

including a very complete archive of known land-product issues with descriptions and examples.

https://landweb.modaps.eosdis.nasa.gov/cgi-bin/QS/new/index.cgi

• HEG: HDF-EOS to GeoTIFF Conversion Tool: Software for reprojecting tiled HDF-EOS products

into many different projections.

https://wiki.earthdata.nasa.gov/display/DAS/HDF-EOS2+to+HDF-EOS5+Conversion+Tool

• MODLAND Tile Calculator: Online tool for performing forward and inverse mapping of MODIS

sinusoidal tiles.

http://landweb.nascom.nasa.gov/cgi-bin/developer/tilemap.cgi

• NASA Earthdata Search: The primary distribution site for most MODIS products. Formerly Reverb,

and before that the Warehouse Inventory Search Tool (WIST), and before that the EOS Data Gateway

(EDG).

https://search.earthdata.nasa.gov/
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Appendix A Coverage of the GeoTIFF subsets

Table 5: Regions and bounding coordinates of the GeoTIFF subsets.

Min. Max. Min. Max.

Window Coverage Lon. Lon. Lat. Lat.

1 Alaska -180 -140.5 50 70

2 Canada -141 -50 40 70

3 USA (Conterminous) -125 -65 23 50

4 Central America -118 -58 7 33

5 South America (North) -82 -34 -10 13

6 South America (Central) -79 -34 -35 -10

7 South America (South) -77 -54 -56 -35

8 Europe -11 35 33 70

9 West and North Africa -19 5 0 37.5

10 Central and North Africa 5 25 0 37.5

11 East Africa and Arabian Peninsula 25 65 0 37.5

12 Southern Africa (North) 8.5 48 -15 5.5

13 Southern Africa (South) 10 41 -35 -15

14 Madagascar 42 59 -27 -10

15 Russia and Central Asia 1 35 90 33 70

16 Russia and Central Asia 2 90 145 33 70

17 Russia (Kamachatka) 145 180 40 70

18 South Asia 60 93 5 36

19 South East Asia 90 155 -10 33

20 Australia 112 155 -45 -10

21 New Zealand 165 179 -48 -33

22 Azores -31.6 -24.8 36.8 40

23 Cape Verde Island -25.5 -22.5 14.6 17.5

24 Hawaii -161 -154 18 24
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Appendix B Coordinate conversion for the MODIS sinusoidal projection

Navigation of the tiled MODIS products in the sinusoidal projection can be performed using the forward

and inverse mapping transformations described here. We’ll first need to define a few constants:

R = 6371007.181 m, the radius of the idealized sphere representing the Earth;

T = 1111950 m, the height and width of each MODIS tile in the projection plane;

xmin = -20015109 m, the western limit of the projection plane;

ymax = 10007555 m, the northern limit of the projection plane;

w = T/2400 = 463.31271653 m, the actual size of a “500-m” MODIS sinusoidal grid cell.

B.1 Forward Mapping

Denote the latitude and longitude of the location (in radians) as φ and λ, respectively. First compute the

position of the point on the global sinusoidal grid:

x = Rλ cosφ (1)

y = Rφ. (2)

Next compute the horizontal (H) and vertical (V ) tile coordinates, where 0 ≤ H ≤ 35 and 0 ≤ V ≤ 17
(Section 1.2.2):

H =

⌊

x− xmin

T

⌋

(3)

V =

⌊

ymax − y

T

⌋

, (4)

where ⌊ ⌋ is the floor function. Finally, compute the row (i) and column (j) coordinates of the grid cell

within the MODIS tile:

i =

⌊

(ymax − y) mod T

w

⌋

(5)

j =

⌊

(x− xmin) mod T

w

⌋

. (6)

Note that for all 500-m MODIS products on the sinusoidal grid 0 ≤ i ≤ 2399 and 0 ≤ j ≤ 2399.

B.2 Inverse Mapping

Here we are given the row (i) and column (j) in MODIS tile H , V . First compute the position of the center

of the grid cell on the global sinusoidal grid:

x = (j + 0.5)w +HT + xmin (7)

y = ymax − (i+ 0.5)w − V T (8)
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Next compute the latitude φ and longitude λ at the center of the grid cell (in radians):

φ =
y

R
(9)

λ =
x

R cosφ
. (10)

B.3 Applicability to 250-m and 1-km MODIS Products

With the following minor changes the above formulas are also applicable to the higher resolution 250-m and

500-m MODIS tiled sinusoidal products.

250-m grid: Set w = T/4800 = 231.65635826 m, the actual size of a “250-m” MODIS sinusoidal grid cell.

For 250-m grid cells 0 ≤ i ≤ 4799 and 0 ≤ j ≤ 4799.

1-km grid: Set w = T/1200 = 926.62543305 m, the actual size of a “1-km” MODIS sinusoidal grid cell.

For 1-km grid cells 0 ≤ i ≤ 1199 and 0 ≤ j ≤ 1199.
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